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Copyright 
Copyright © Nedap N.V. All rights reserved. The information in this document is subject to change without notice, it is 
not to be reproduced in any way, in whole or in part, without the written consent of Nedap N.V. All trademarks 
referenced belong to their respective owners 
 
Disclaimer 
Nedap N.V. has made every effort to ensure the accuracy of the information contained in this document. However, 
Nedap N.V. makes no representations or warranties whatsoever whether express or implied as to the accuracy, 
correctness, completeness or fit-for-purpose or suitability for the purpose of this product. You use the products at your 
own risk. Nedap N.V. excludes any liability to the maximum extent permitted by applicable law for the damages caused 
by errors or failures made during the installation or improper use of this product or by not applying the instructions 
stated in this document. 
 
Nedap N.V. reserves the right to make improvements or amendments to this document and/or the products described 
therein at any time without any notification. The latest version of this document can be found on our partner portal 
https://portal.nedapidentification.com. Please download the latest version of this document and keep a copy for your 
own records. 
 
This document can be published in various languages but only the English language version will prevail. Nedap N.V. 
assumes no responsibility for any errors caused for the translations into another language. 
 
Warranty and spare parts 
Please consult the Nedap products dealer from whom you purchased this product, in regards to the applicable warranty 
conditions. This product cannot be used for any other purpose as described in this document. If the product is not 
installed according to this document; the warranty provided is not applicable. At the sole discretion of Nedap N.V., 
Nedap N.V. may decide to change the conditions of the warranty policy. You agree that Nedap N.V. is able to 
compensate you the pro-rata value of the warranty involved rather than replacing or repairing the product depending 
on the technical or economical value of the product. 
 
Prior to applying the warranty, please verify if you comply with the warranty conditions of the warranty policy, whether 
you can successfully apply for the replacement or repair of a defective part. Parts can only be replaced with original 
Nedap parts, otherwise the warranty policy will not be applicable on the product. If the warranty is applicable, please 
contact the dealer or send the defective parts to the dealer. 
 
Additional information 
For any information or questions regarding the product, please contact your own dealer 
 
  

Nedap N.V. 
Identification Systems 
Parallelweg 2 
7141 DC Groenlo 
The Netherlands 
 
+31 (0)544 471 111 
info@nedapidentification.com 
www.nedapidentification.com 

https://portal.nedapidentification.com/
http://www.nedapidentification.com/
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1 Introduction 
The Prox-Booster and Smartcard-Boosters are dual-ID tags enabling simultaneous identification of the inserted 
personal ID card and the embedded vehicle ID resulting in rapid driver and vehicle monitoring. 
 
The Booster allows an inserted Proximity or Smartcard driver ID card and embedded vehicle ID to be read from a 
distance up to 10 meters (33 feet) in combination with NEDAP TRANSIT readers. This solution substantially enhances 
the level of security when controlling activities of vehicles that are regularly used by different drivers.  
Additionally, a fully integrated vehicle and personnel access solution can be implemented. 
 
The Smartcard-Booster Ultimate additionally supports encrypted authentication using diversified AES128 bit keys, in 
combination with the TRANSIT Ultimate and the Security Key Pack. 
 
For more details about the NEDAP TRANSIT Ultimate reader refer to the corresponding installation guide. 
 
The combined vehicle and driver ID is a unique NEDAP patented feature. 
Optionally the Booster can also be operated in single-ID mode, in applications where only the personal ID card is used. 
 
The following personal ID card types are supported with the Boosters: 
 
• Prox-Booster 2G    NEDAP 

   HID-PROX 
   EM4100 and compatible 

  
• Smartcard-Booster 2G 
• Smartcard-Booster Ultimate 

   MIFARE Classic 
   MIFARE Ultralight 
   MIFARE DESfire EV1/EV2/EV3 
   HID iCLASS UID 
   ISO14443A CSN 
   ISO15693 UID 
   Calypso PUPI and free files 

 
 
Warning: Do not leave card in the Booster when leaving the vehicle, as this presents a security risk! 
 
Warning: Do not leave card in the Booster for long periods of time in extreme heat, as this may damage the card! 
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2 Installation 
2.1 Dimensions 
The Booster is easily mounted to the inside of the car’s windshield by means of suction cups. Users should ensure the 
visual contact between the Booster and TRANSIT reader is unobstructed with items such as stickers or metallized 
windshields (see also chapter 2.3 about solar control windshields). 
Note that the Booster's suction cups must be faced toward the reader to achieve maximum reading distance. 
 

 

 

Dimension    
Length X 111 mm 4.37 " 
Width Y 65 mm 2.56 " 
Height Z 32 mm 1.26 " 
Body height H 24 mm 0.95 " 
    

Figure 1: Booster dimensions 

 

2.2 Temperature considerations 
The Booster is designed to operate within the extreme temperature ranges, which often occur behind a vehicle’s 
windshield during the winter or summer seasons (-20°C to 85°C / -4°F to +185°F). However, the personal ID card 
inserted in the Booster may not be designed to withstand such temperatures and could suffer damage as a result. 
 
Nedap recommends to remove the personal identification card when not in use. 
 

2.3 Solar control windscreens 
From 1997 onwards, several car manufacturers introduced vehicles with solar control windshields. The solar control 
windshields are equipped with a metalized coating, which can block the TRANSIT signal from the Booster mounted on 
the inside of the windshield of the vehicle. 
Most of these windshields have a metal free zone where transponders can be mounted. The metal free zone of 
metalized windshields is most often found in the middle of the windshield behind and slightly below the rear-view 
mirror. In vehicles manufactured after 1998 the metal free zone should be indicated on the window. 
We advise the owner to contact the local car dealer if it is not clear where the aperture is exactly positioned in a certain 
vehicle and where the transponder should be mounted.  

X 

Y 

H Z 
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3 Identifying the Booster with a TRANSIT 
3.1 How to use the Booster 
Place the Booster on the inside of the windscreen of your vehicle as described in chapter 2. The driver inserts his 
personal ID card and activates the Booster’s button. 
 
A beep should indicate that the card was successfully read. A low beep indicates that card reading failed. See chapter 6 
for details about the buzzer indications. 
 
The TRANSIT reader can identify your card up to a distance of 10 meters (=33 ft).  
 
After 5 seconds the Booster returns into sleep mode. The booster will remain active when in 'always-on'-mode. 
 
The driver should remove his personal ID card from the Booster when leaving the vehicle. 
 

3.2 Reader output 
The Booster is a battery operated passive tag. The information from the tag is sent to the reader by a method called 
modulated backscatter. This means that the 2.45GHz signal coming from the reader's antenna is modified in such way 
that it can be recognized by the reader.  
 
The examples below assume that a TRANSIT reader with P81 firmware is used and show the messages transmitted on 
the RS232 interface to a host system (TXD). Refer to the TRANSIT firmware manuals for more details about the reader 
communication protocol. 
 

3.2.1 Dual ID mode (Vehicle ID + Driver ID) 
The Booster is inactive until the driver inserts his personal ID card and pushes the Booster’s button. Once the button is 
pushed the Booster reads the personal ID card and beeps upon a successful read. Both vehicle-id and driver-id are 
transmitted to the reader for 5 seconds. Afterwards the Booster automatically deactivates again. The booster will 
remain active when in 'always-on'-mode. 
 
Example 
vehicle-id = 123, driver-id = E4947C46: 
 

If 'Extended-length (default)' is configured, the following message is transmitted to the host: 

TXD = Y000000012300000000000000E4947C46P

C
PRRRP

L
PRFR  

 
If 'Standard-length' is configured, the following message is transmitted to the host: 

TXD = U000000012300E4947C46P

C
PRRRP

L
PRF 

  Event identifier ('Y' or 'U'). 
  Vehicle-id (10 digits). 
  Driver-id (10 or 22 digits). 
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3.2.2 Single ID mode (only Driver ID) 
The Booster is inactive until the driver inserts his personal ID card and pushes the Booster’s button. Once the button is 
pushed the Booster reads the personal ID card and beeps upon a successful read. The data is transmitted to the reader 
for 5 seconds. After that the Booster automatically deactivates again. Always-on-mode is not supported in single-ID 
mode. 
 
Example 
driver-id = 871111111117100944: 
 

If 'Extended-length (default)' is configured, the following message is transmitted to the host: 

TXD = Z00000000000000871111111117100944P

C
PRRRP

L
PRFR  

 
If 'Standard-length' is configured, the following message is transmitted to the host: 

TXD = U00871111111117100944P

C
PRRRP

L
PRF 

  Event identifier ('Z' or 'U'). 
  Driver-id (20 or 32 digits). 
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4 Smartcard configuration 
The Smartcard-Booster can be configured by means of a configuration card. This configuration card is programmed 
with the configuration settings. 
 
Configuration is only required if the factory default settings are not sufficient. The default settings are described in 
chapter 4.7. 
 

4.1 Configuration procedure 
Every Booster used in the application should be configured with the configuration card. The easy configuration 
procedure is described below. 
Insert the configuration card in the Booster and push the button. The Booster sounds the buzzer with an increasing 

frequency (♪ ♪ ♪) to indicate that the configuration card is accepted. 

 

4.2 Config card types 
The configuration card must be a Mifare card of below type. 
 
• Mifare Classic 1K / 4K * Accepted by all Smartcard-Boosters 
• Mifare Desfire EV1 ** Not accepted by older Smartcard-Boosters 
 
* Notes about Mifare Classic config cards 
The Mifare Classic config cards are accepted by all Smartcard-Boosters including the very first models from year 2007. 
 
Warning: the security of the Mifare Classic cards has been compromised. Therefore allow only trusted parties to 
perform the configuration and keep the configuration cards in secure location. 
 
** Notes about Mifare Desfire EV1 config cards 
Mifare Desfire EV1 config cards ensure a high level of security. 
 
Desfire config cards are only accepted by Smartcard-Booster 2G and Smartcard-Booster Ultimate since year 2019. 
 
How to identify if Smartcard-Booster supports Desfire EV1 config cards? 
Yes, if the Booster is marked with revision B next to product number. E.g. '9948554 B' or '9982809 B'. 
Yes, if the Booster plays Dutch national anthem when button is pressed while inserting the batteries. 
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4.3 How to create a configuration card 
The configuration cards are created using the NEDAP Smartcard-Booster configuration software. This software can be 
downloaded from our partner portal; https://portal.nedapidentification.com. 
 

 
Figure 2: Smartcard-Booster configuration software 

 

4.3.1 Target device 
The Smartcard-Booster Configuration software is typically used to configure the Smartcard-Booster. However it also 
supports some older (no longer available) booster models. The user-interface is adapted to the selected target device. 
Select in the ‘Target’ menu which booster model you are about to configure. 
 
• Smartcard-Booster 
• Transition Booster (old) not covered in this manual 
• Prox Booster EM4x50 / Titan (old) not covered in this manual 
 

4.3.2 Creation procedure 
Follow the procedure below to create a configuration card with application specific settings. 
 
1. Specify BOOSTER OPTIONS see chapter 4.3.3. 
2. Specify CARD READ SETTINGS see chapter 4.3.4. 
3. Write the configuration into a config card see chapter 4.4. 
4. Save the configuration settings into a file see chapter 4.6. 
 
See next chapters for more details. 
 
  

https://portal.nedapidentification.com/
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4.3.3 Booster options 
4.3.3.1 Operating mode 
Select Booster operating mode. See available options below. 
 
Booster (only Driver-ID) 
Single ID operation. Up to 16 bytes of data from the personal ID card is read. The Vehicle-ID is omitted. 
 
Combi-Booster (Vehicle-ID + Driver-ID) 
Dual ID operation. Vehicle-ID combined with up to 11 bytes from the personal ID card. 
 
Tacho-Booster (Vehicle-ID + Driver-ID + Tacho-Counter) 
Vehicle-ID and Driver-ID combined with Tacho-Counter value. If this option is selected than automatically extended-
length is selected. See chapter 5 for more information about tacho booster function. 
 
4.3.3.2 Active mode 
Two activation modes are possible: Switched or Always-on. 
The setting can only be changed when the Booster originally was in switched mode! 
Switched mode is selected when the operating mode is Booster (only Driver-ID). 
 
Switched mode (active for ± 5 seconds) 
In switched mode the booster is active for approx. 5 seconds after the reading the inserted card (button is pushed). 
 
Always-on (continuously active) 
In always-on mode the booster remains active. When the booster's button is pushed the booster will read the inserted 
card. If a card was identified, the booster will check every few minutes if the inserted card is still present. 
 
4.3.3.3 Frame length 
Extended length (default) 
Select extended-length in order to support all transponder types and maximum amount of data. The identification 
speed is a bit slower compared to applying standard-length. 
 
Standard length (backwards compatible, faster identification) 
Select standard-length in applications where compatibility with older types of transponders or where fast identification 
is important. 
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4.3.4 Card read settings 
Enable the card types you want the Booster to read. Different contactless smartcard types are supported. Also multiple 
technologies may enabled in case of card migration scenarios. For example from Mifare Classic to Desfire. 
 
Mifare 
Select one of the following choices: 
• CSN Card serial number (4 or 7 byte). 
• MIFARE Classic sector data See chapter 4.3.4.1. 
• MIFARE UltraLight data See chapter 4.3.4.2. 
The byte order can be set to normal or reversed. 
 
Desfire 
• Desfire file data See chapter 4.3.4.3. 
 
Other cards 
• HID iCLASS CSN Read HID iCLASS card serial number (8 byte). 
• ISO15693 / LEGIC Advant CSN Read ISO15693 (LEGIC Advant ATC-MV) card serial number (8 byte). 
• I∙CODE Read NXP I∙CODE card serial number (8 byte). 
• Calypso See chapter 4.3.4.4. 
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4.3.4.1 Mifare Classic sector data 
The Mifare Classic 1K and 4K cards are fully supported. The memory is organized in sectors with blocks. Every block 
contains 16 bytes. The Mifare Classic cards are protected by the Crypto1 security. 
 
Specify the following parameters; 
 
Sector number 
Sector number to read data from (in range from 0 to 39). 
 
Block number 
Block number to read data from. The block number must be in range from 0 to 3 for the first 32 sectors. For the sectors 
32 to 39 the block number can range from 0 to 15. 
 
Data length 
Number of bytes to read. The maximum number of bytes depends upon operating-mode and frame-length. 
 
Data offset 
Number of bytes to skip. 
 
Read key 
Select read key A or B and enter the actual read key value. 
 
Example 

Data to read: Mifare Classic sector data 
Byte order: Normal byte order 
Sector number: 1 
Block number: 1 
Data length: 8 
Data offset: 2 

 
Sector Block 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

1 0 x x x x x x x x x x x x x x x x 
1 x x D D D D D D D D x x x x x x 
2 x x x x x x x x x x x x x x x x 
3 x x x x x x x x x x x x x x x x 

 
Reverse example 

Data to read: Mifare Classic sector data 
Byte order: Reverse byte order 
Sector number: 2 
Block number: 0 
Data length: 10 
Data offset: 2 

 
Sector Block 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

2 0 x x x x x D D D D D D D D D D x 
1 x x x x x x x x x x x x x x x x 
2 x x x x x x x x x x x x x x x x 
3 x x x x x x x x x x x x x x x X 
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4.3.4.2 Mifare Ultralight data 
Mifare UltraLight cards have 512-bit EEPROM memory, which is organized in 16 pages with 4 bytes each. These are 
low-cost contactless smartcards that do not offer any security features. The Mifare Ultralight C authentication is not 
supported. 
 
Specify the following parameters; 
 
Page number 
Page number to start reading from (in range from 0 to 15). 
Always 4 pages are read. The reading will wrap around to page number 0 if additional data after page 15 should be 
read. 
 
Data length 
Number of data bytes to read. The maximum number of bytes depends upon operating-mode and frame-length. 
 
Data offset 
Number of data bytes to skip. 
 
Example 

Data to read: MIFARE UltraLight data 
Byte order: Normal byte order 
Page number: 4 
Data length: 8 
Data offset: 2 

In this example the reading starts at page 4. The first 2 bytes are skipped because the offset is set to 2. The following 8 
bytes are read from the card as configured data length is 8  Driver-ID = 0102030405060708. 
 
 Byte 0 Byte 1 Byte 2 Byte 3 
Page 4 skipped skipped 01 02 
Page 5 03 04 05 06 
Page 6 07 08 ignored ignored 
Page 7 ignored ignored ignored ignored 
 
Reverse example 

Data to read: MIFARE UltraLight data 
Byte order: Reverse byte order 
Page number: 5 
Data length: 6 
Data offset: 1 

In this example the reading starts at page 5. The first byte is skipped because the offset is set to 1. The following 6 
bytes are read from the card. Finally, the bytes are reversed  Driver-ID = 060504030201. 
 
 Byte 0 Byte 1 Byte 2 Byte 3 
Page 5 skipped 01 02 03 
Page 6 04 05 06 ignored 
Page 7 ignored ignored ignored ignored 
Page 8 ignored ignored ignored ignored 
  



Booster | installation guide 

 14/25 

 

4.3.4.3 Desfire file data 
Desfire cards are fully supported, including DESFIRE EV1/EV2 cards with 3DES, 3 Key 3DES and AES encryptions. 
 
The DESFIRE card's memory is organized using a flexible file system. This file system allows several different 
applications on a single card. Every application is identified by its 3-byte application identifier (AID). Each application 
may contain up to 32 files. 
 
Specify the following parameters; 
 
Application ID 
Three-byte application identifier (AID). For example; F12345. 
 
File number 
File number in the range from 0 to 31. 
 
Communication mode 
File communication mode. This can be either; 
• Plain 
• Plain secured by MACing 
• Fully enciphered 
 
Data length 
Number of data bytes to read. The maximum number of bytes depends upon operating-mode and frame-length. 
 
Data offset 
Number of data bytes to skip. 
 
Encryption 
Authentication method. Select one of below options; 
• None (skip authentication) 
• Native DES/3DES 
• ISO DES/3DES 
• 3 Key 3DES 
• AES 
 
Key number 
Read key number in range from 0 to 13. 
 
Key 
Read key. The length encryption key is 16 bytes (24 bytes for 3 Key 3DES). 
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4.3.4.4 Calypso 
For Calypso cards the 4-byte PUPI or information from always accessible files can be read. 
The Booster does not support the Calypso SAM to fully support the Calypso encrypted file system. 
 
Data to read 
Select one of the following choices: 
• PUPI (pseudo unique PICC identifier) 
• Calypso file data 
 
Byte order 
The byte order can be set to normal or reversed. 
 
Short File Identifier 
Calypso SFI (Short File Identifier) in range from 1 to 30. 
Note that it is required that the file does have a SFI. 
 
Record number 
A file may contain more than one record. Numbered from 1 to the maximum number of records. 
 
Data length 
Number of data bytes to read. The maximum number of bytes depends upon the operating-mode and frame-length. 
 
Data offset 
Number of data bytes to skip. 
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4.4 Program the configuration card 
4.4.1 Using a supported programmer 
The software supports a few different smartcard programming devices. Below a list of tested supported devices are 
show. Other PC/SC compatible contactless smartcard reader may also be supported. 
 
Supported programmers 
• ACS ACR122U 
• HID OMNIKEY 5022-CL 
• HID OMNIKEY 5321-CL 
• Springcard CSB6 / Prox’N’Roll PC/SC 
• NXP Pegoda CL RD701 
 
Make sure to install the proper USB drivers for the programmer according to the manufacturer’s documentation. 
 
Connect 
Select the used programmer type in the ‘Programmer’ menu.  
 
When multiple supported programmers are found upon connect, the software will prompt to select the device of your 
choice. 
 
Programming 
Once the connection has been established and all configuration settings are entered, place an (empty) config card on 
the programmer. 
 
Click ‘Write configuration into card’ in the ‘Programmer’ menu to program the configuration into the config card. 
The message ‘Configuration written into card’ appears to indicate that the programming action was successful. 
 
The software will warn you with the message ‘Overwrite configuration card’ if there is already a configuration on the 
config card. Click ‘Yes’ to proceed and overwrite the configuration on the card or click ‘No’ to abort. 
 
Read back 
It is also possible to read back what configuration is programmed into a configuration card. Click ‘Read configuration 
from card’ in the ‘Programmer’ menu. 
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4.4.2 Using another programmer 
If there is no supported programmer available you can use any other Mifare programmer to write the configuration into 
a Mifare Classic config card (programming a Desfire config card requires to use a supported programmer). 
 
The configuration data should be written into sector 1 and 2 of a Mifare Classic 1K or 4K card. The contents of these 
sectors are not explained, but can be shown by the configuration software by clicking ‘Show configuration details’ in the 
‘Expert’ menu. 
 

 
Figure 3: Configuration data details 

 
Sector 0 is reserved for MAD (Mifare Application Directory). If the MAD is programmed, the Nedap configuration sectors 
should have application id 517F. 
 
Copy to clipboard 
Copy the configuration data to clipboard by clicking ‘Copy to clipboard’ in the ‘Edit’ menu.  
 
Customizing view 
In the ‘View’ menu the viewing can be customized in such way that it best matches your programming software. 
Click ‘Change Hex Prefix…’ to specify a specific prefix that is shown before every configuration data byte. Below is 
shown the configuration data with prefix ‘0x’. 
 
0x77 0x77 0x77 0x2E 0x6E 0x65 0x64 0x61 0x70 0x61 0x76 0x69 0x2E 0x63 0x6F 0x6D  
0x4E 0x01 0x01 0x07 0x07 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x4E  
0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00  
0xA0 0xA1 0xA2 0xA3 0xA4 0xA5 0x78 0x77 0x88 0x00 0xB0 0xB1 0xB2 0xB3 0xB4 0xB5 
 
Besides the hex prefix also the byte order can be changed from within the ‘View’ menu.  



Booster | installation guide 

 18/25 

 

4.5 Testing the configuration 
The Mifare and Desfire settings can be tested before loading it into the Smartcard-Booster using a supported reader. 
From the ‘Programmer' menu choose ‘Test configuration’. 
 
Place the user card (not the config card) on the reader and click the ‘Read’ button. 
The reader reads the card according to the current configuration settings. 
 
The software displays the driver-id number as it will be read by the Smartcard-Booster. 
 

 
Figure 4: Configuration test 

 
If the card is not read or if the wrong data is shown under Driver-ID then check if the configuration settings are correct. 
Remember that only Mifare and Desfire cards can be tested this way. 
 
 

4.6 Configuration files 
Your configuration can be saved into a so-called Smartcard Booster Config File (*.sbcf). 
 
These files contain all the configuration settings as you have defined them. 
The file itself is encrypted to ensure that the configuration data remains secret. 
 
Saved Config Files can be easily opened from within the File menu. 
Obviously, the configured keys are not shown after file read back. 
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4.7 Default configuration 
The table below shows the default Smartcard-Booster configuration. 
 

Configuration settings Default value 
Operating mode Combi-Booster (Vehicle-ID + Driver-ID) 
Frame length Extended-length (longer Driver-ID) 
Active mode Switched mode 
MIFARE/DESFIRE Enabled (CSN) 
Byte order Normal 
HID iCLASS CSN Enabled 
ISO15693 / LEGIC Advant CSN Enabled 
I∙CODE Disabled 
Calypso Disabled 
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5 Tacho booster 
The tacho booster function requires the Booster to be wired to the speed pulse generator of your vehicle. The Booster 
will count the number of pulses generated, which indicate the vehicle’s mileage. 
 
Tacho input specifications 
• Input voltage: 6V to 24V (max. 30V). 
• Polarity reversal tolerant. 
• Input prescaler 1:256. 
• Maximum pulse frequency 850Hz. 

• Maximum vehicle speed 255km/h (at 12 pulses/meter) hkm /2556.3
12
850

=×=  

 
The exact wiring details and connection location very much depend upon the brand, type and model of your vehicle. 
Contact your vehicle dealer for more information about the speed pulse generator in your vehicle. 
 
Reader output 
The driver inserts his personal ID card and pushes the Booster’s button. Once the button is pushed the Booster reads 
the personal ID card and beeps upon a successful read. Both vehicle-id, driver-id and tacho-counter are transmitted to 
the reader for 5 seconds. Afterwards the Booster automatically deactivates again (unless in 'always-on' mode). The 
Booster will keep updating the tacho counter also while inactivate. 
 
Example: reader output: vehicle-id = 123, driver-id = E4947C46, tacho-counter = 100000 pulses (=hex 186A0): 

TXD = X000000012300E4947C4680000186A0P

C
PRRRP

L
PRFR  

  Event identifier ('X' = triple identifier detection event). 
  Vehicle-id (10 digits). 
  Driver-id (10 digits). 
  Additional data identifier ('80' = tacho counter). 
  Additional data (in this case the tacho counter value). 

 
How to calculate the constant factor required to convert tacho counter value into travelled distance. 
• Get the vehicle's initial mileage )( 1M=  and the initial tacho counter value )( 1T=  

• Drive the vehicle for a significant number of miles (or kilometres). 
• Then again get the actual mileage )( 2M=  and the actual tacho counter value )( 2T=  

• Now calculate the number of counts per mile (or km) by using the following formula: 
( )
( )12

12

MM
TTK

−
−

=  

 
How to calculate the vehicle's travelled distance. 
• Get the actual tacho counter value   
• Calculate travelled distance by using the following formula: 

( )
K

TTD n
n

1−
=  

• Calculate the current mileage by using the following formula: 

1MDM nn +=   
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6 Buzzer indications 
The Booster's built-in buzzer gives audible feedback upon various conditions. The table below describes the buzzer 
indications. 
 

Description Buzzer 
Card read 1 high tone beep 
Failed to read card (not in configuration) 1 short low tone beep  
Configuration card accepted 3 beeps increasing frequency ♪ ♪ ♪ 

Power on (Smartcard-Booster) 6 beeps increasing frequency 
Power on (Prox-Booster) 3 beeps 
Power-on + button (revision B: will accept Desfire config card) Dutch national anthem 
Battery low Morse SOS ( ∙ ∙ ∙ – – – ∙ ∙ ∙ ) 
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7 Battery replacement 
The Booster contains two replaceable non-rechargeable AAA batteries. The average lifetime of these batteries is 
approximately 5 years. When replacement becomes necessary follow the procedure below. 
• Open the battery compartment. 
• Remove both batteries. Follow local environment protection laws / regulations for disposal of used batteries. 
• Replace with two new batteries. Make sure that the polarity matches the indicated polarity. Refer to appendix A for 

battery requirements. 
• Close the battery compartment and verify that the Booster is working properly. 
 

 
Figure 5: Battery replacement 
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A Technical specifications 
Item Specification Remark 

Part numbers 
9948538 – Prox-Booster 2G 
9948554 – Smartcard-Booster 2G 
9982809 – Smartcard-Booster Ultimate 

 

Dimensions 111 x 65 x 24 mm [ 4.4 x 2.6 x 1.0 in ]  
Weight 120 grams [ 4.2 oz. ]  
Housing PC and TPU  
Color Grey RAL 7016 / RAL 7040 
Protection IP32 Approx. NEMA 2 
Operating frequencies 2.45 GHz / 120 kHz / 13.56 MHz 433 MHz only Smartcard-Booster Ultimate 

Supported RFID cards 
(Prox-Booster) 

NEDAP 
HID-PROX 
EM4100 and compatible 

Supported RFID cards 
(Smartcard-Booster) 

MIFARE Classic, Ultralight, DESFire EV1/EV2/EV3 
ISO15693 UID (LEGIC Advant ATC-MV) 
HID iCLASS UID 
Calypso PUPI and free files 

Operating temperature -20°C … +85°C [ -4°F … +140°F ]  
Storage temperature -40°C … +85°C [ -40°F … +140°F ]  
Relative humidity 10% … 93% non-condensing 
Identification range Typically 10 meters [ 33 ft ] line-of-sight required 
Battery, size AAA, 1.5V 2 x Alkaline or Energizer Lithium L92 expected lifetime up to 5 years 
Certifications CE, FCC and ISED  

 
 

B Disposal of equipment 
The products will be disposed of by the end-user and discharge Nedap for any liability or responsibility thereof. 
 

The WEEE symbol in Europe indicates that the relevant electrical product or battery should not be 
disposed of as general household waste in Europe. To ensure the correct waste treatment of the 
product and battery, please dispose them in accordance to any applicable local laws of requirement for 
disposal of electrical equipment or batteries. In so doing, you will help to conserve natural resources 
and improve standards of environmental protection in treatment and disposal of electrical waste 
(Waste Electrical and Electronic Equipment Directive WEEE 2012/19/EU). 

 
 

C CE declaration 
Hereby, Nedap N.V. declares that the subject equipment is in compliance with directives 2014/53/EU (Radio 
Equipment Directive) and 2011/65/EU (RoHS). The full text of the EU declaration of conformity is available at the 
following internet address: https://portal.nedapidentification.com.  

https://portal.nedapidentification.com/
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D FCC / ISED statement 
Prox-Booster 2G FCC ID: CGDBOOSTER4 / IC: 1444A-BOOSTER4 
Smartcard-Booster 2G FCC ID: CGDBOOSTER7 / IC: 1444A-BOOSTER7 
Smartcard-Booster Ultimate FCC ID: CGDBOOSTER10 / IC: 1444A-BOOSTER10 
 
FCC and ISED Compliance statement 
This device complies with part 15 of the FCC Rules and contains licence-exempt transmitter(s)/receiver(s) that comply 
with Innovation, Science and Economic Development Canada's licence-exempt RSS(s). Operation is subject to the 
following two conditions: (1) this device may not cause interference and (2) this device must accept any interference, 
including interference that may cause undesired operation of the device. 
Changes or modifications not expressly approved by the party responsible for compliance could void the user’s 
authority to operate the equipment. 
L’émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux CNR d’Innovation, 
Sciences et Développement économique Canada applicables aux appareils radio exempts de licence. L’exploitation est 
autorisée aux deux conditions suivantes: (1) l’appareil ne doit pas produire de brouillage et (2) l’appareil doit accepter 
tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre le fonctionnement. 
Les changements ou modifications n’ayant pas été expressément approuvés par la partie responsable de la conformité 
peuvent faire perdre à l’utilisateur l’autorisation de faire fonctionner le matériel. 
 
FCC and ISED Radiation Exposure Statement 
This equipment complies with FCC (OET Bulletin 65) and Canadian radiation exposure limits set forth in RSS-102 for an 
uncontrolled environment. This equipment should be installed and operated with a minimum distance of 0 mm 
between the radiator and your body. This transmitter must not be co-located or operating in conjunction with any other 
antenna or transmitter. 
Cet équipement est conforme à CNR-102 limites énoncées pour un environnement non contrôlé. Cet équipement doit 
être installé et utilisé avec une distance minimale de 0 mm entre le radiateur et votre corps. 
 
ISED EMC Declaration 
This Class B digital apparatus complies with Canadian ICES-003. Cet appareil numérique de Classe B est conforme à la 
norme Canadienne ICES-003. 
 
FCC Information to the user 
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference 
to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help 
Any changes or modifications not expressly approved by the party responsible for compliance could void the user’s 
authority to operate the equipment. 
US responsible party: Nedap Inc., 25 Corporate Drive (Suite 101), MA 01803 Burlington, USA, 781 349 6200.  
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E Document revision 
Version Date Comment 
4.9 2022-01-19 Updated supported RFID cards 
4.8 2021-01-26 HR update: technical specifications battery information 
4.7 2020-09-07 Updated REW 
4.6 2020-09-04 Updated compliance statements 
4.5 2020-04-29 Updated corporate style 
4.4 2019-05-28 Added Desfire configuration 
4.3 2016-03-23 Added document number 
4.2 2015-05-19 Added smartcard-Booster  Ultimate 
4.1 2014-04-29 HR update 
4.0 2014-02-13 Created 
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